Lab 1: Measurement, Error, and Body Temperature

October 5, 2006

Introduction
Preparation
Before coming to lab, you should have read through the lab handout “An Introduction to Measurement and Uncertainty.” You should also have become familiar with the Logger Pro software
by downloading it and trying tutorials 1, 5, 7 and 9.

Background
“Common knowledge” has it that the body temperature of a healthy human is 98.6◦ F. Is this really
true? How different are temperatures for different people? Do women and men have different
average temperatures? Is normal body temperature related to other physiological parameters, such
as heart rate? We will explore the answers to these and other questions in the lab. But first, we
will have to learn some things about measurements and uncertainties.

Overview and Objective
In the first part of this lab, you will simulate the processes that lead to random error and explore
why the measurements that scientists make have uncertainty, and why the normal distribution is
a good model for the distribution of repeated measurements. In the second part of the lab, you
will use this knowledge to study the properties (accuracy, precision, etc.) of several commercial
thermometers, and also look at the distribution of body temperatures among students in the class.
Objectives for this lab:
1. Learn to use the Logger Pro software and the LabPro interface
2. Understand the concept of distributions
3. Understand the size and nature of random measurement error, and learn how to analyze it
4. Analyze the correlation between two measurements and identify the relationship between
them
5. Understand the distribution of body temperatures: mean, standard deviation, and correlation
with other variables

Theory
All of the theory for this lab can be found in the handout on error and measurement, which you
should have read (and at least tried to understand) before coming to lab.
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Materials
At your work station you should find the following materials:
• Two six-sided dice of different colors
• One ten-sided die
• One twelve-sided die
• Nine pennies
• Three different commercial thermometers
• Thermometer probe covers

Procedure
Before you begin doing the lab, take a picture of your lab group (you should be working in groups
of three) using the Photo Booth software. Then open the NoteBook software and begin a new
notebook. This will be your “lab report” for today’s lab. You will add to the notebook as you
work through the steps of the lab. To begin with, drag the picture you just took of your lab group
into the notebook and put it at the top. Then label the picture with your names so that we can
learn who you are.
Throughout the lab, you will record your observations and the answers to the discussion questions in the NoteBook file, so keep the application open. You can record your lab activities either
as text or as audio (using the Voice Annotation feature), or any combination of the two. The software was designed to be as easy to use as possible. For information on getting started or moving
around, see the handout “Tips for using NoteBook.” If you need more help with NoteBook (or
Photo Booth), ask your lab TF.
I. Twelve-sided die versus two six-sided dice
(A) Start Logger Pro and open the file called “Lab 1.cmbl” in the folder “Lab1” on your
Desktop. The first thing you should do is save a copy of this file onto the desktop with a
different file name, preferably one that contains the names of you and your lab partners.
That way, you can periodically save your work without overwriting the original file.
Saving often is a very good idea; people have been known to kick out power cords, and
computers have been known to crash. Heaven forbid any of these should happen to you,
but if you save often, it will be only a minor annoyance rather than an outright disaster.
(B) The first page of the Logger Pro file has three columns for you to fill in: 12-sided die,
Black 6, and White 6. For each row in the table, simply roll the dice. Record the value
on the twelve-sided die (d12) in the first column, and the two six-sided dice (2d6) in the
second and third columns. The program will automatically compute the sum of the two
six-sided dice for you in the column labeled Sum of 6’s. Do this 100 times (it shouldn’t
take very long, especially if you work together with your lab partners).
(C) Once you have filled in the table, make a histogram of your results, comparing the
distribution of results from the d12 to the sum of the 2d6. Do this by going to the
Insert menu and selecting Additonal Graphs → Histogram. Place the histogram to the
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right of the data table. You can either make two histograms, one for each column of
data, or put both onto the same histogram using bars of different colors. Double-click
on the histogram and click the Bin and Frequency Options tab to change the options for
the histogram; you will need to do this to select which column to display in histogram
format. The other important option to set is the bin width. Here, with only discrete
values possible, you should make the bin size equal to 1. When you have made the
histograms, copy them into your NoteBook file (you can simply drag and drop them into
the NoteBook window).
(D) You should notice a definite difference between the d12 histogram and the 2d6 histogram,
even apart from the fact that it is impossible to get a total of “1” when rolling two sixsided dice. What can you say about the distributions of the d12 outcomes? Of the 2d6
outcomes? Put your observations in your NoteBook file.
Are all of the outcomes equally likely in both cases? What is the “expected” distribution
for the two columns? Do your histograms look like you would expect? Can you explain
why rolling a single die gives you a uniform distribution while rolling two dice and adding
them does not? Discuss these questions with your lab partners (and with your TF, if
necessary). When you agree on the answers, jot them down in your NoteBook file as
well.
(E) When you are finished, save your Logger Pro file, and then let your TF know so he or
she can collect your data. The TF will combine all of the data from the entire class
into a single histogram. How closely do the combined histograms resemble the expected
distribution for the two cases? Do they look very different from the data taken only
by your group? The TFs will also copy the plot of the whole class’s histogram to your
Desktop; copy it into your NoteBook file and compare it to the one from just your own
data.
II. Ten-sided die vs nine coins
(A) Now move to page two of the Logger Pro file using the
Next Page button. You will
perform a very similar experiment as in part I, except this time the two columns are
labeled 10-sided die and 9 coins. The idea is the same: roll the 10-sided die (the faces
are labeled 0 through 9), and record the result in the first column. Flip nine coins and
record how many result in heads (this should also be a number between 0 and 9) in the
second column. Repeat 50 times.
(B) Make a histogram (or two histograms) of your results, just as you did on the previous
page, and again put a copy of it into your NoteBook file. What can you say about
the two distributions? Here you are comparing the distribution from a single random
event (the die roll) to the distribution resulting from the sum of 9 random events (the
coin tosses). The distinction should be even more sharply visible than it was in part I.
Record your observations in the NoteBook file.
(C) As before, save your work and then let your TF know when you are finished. The TF
will combine all of the data from the entire class into a single histogram, and again copy
it to your computer. How closely do the combined histograms resemble the expected
distributions?
III. Simulating random error
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(A) Now move to page three of the Logger Pro file, again using the
Next Page button.
In this part, you will model the experimental error of a hypothetical measuring device
and determine if the error follows a normal distribution. The rules for each source of
error are as follows:
• The average must be zero. This is to avoid introducing systematic (as opposed to
random) error into the measurement.
• The error must be bounded between -10 and +10.
The idea behind the simulation is this: imagine you are trying to measure some quantity
whose “true” value is 100 (no units). But your instrument, or your measuring setup,
is subject to several sources of random error, which obscure the true value, so that the
result you see is the sum of the true value and the three sources of error.
(B) The three sources of “error” will be generated randomly as follows:
1. Dice. Roll two six-sided dice, and subtract the number showing on one die from
the other die. This will produce a random number between −5 and +5. In fact,
since you have already rolled a pair of dice 50 times, we’ll just re-use those results.
Logger Pro has automatically subtracted your die rolls from part I and copied them
into the column Dice.
2. Coins. Flip nine coins, count the number of heads, and subtract from that the
number of tails. The result will be a random number between −9 and +9. Again,
you have already done this 50 times, so we’ll re-use the results of those coin flips.
They should automatically appear in the column labeled Coins in the data table.
3. Phone book. Open a telephone book to a random page, and then find the first and
last phone numbers on that page. Take the last digit of each phone number, and
subtract them (the last digit of the first phone number, minus the last digit of the
last phone number). The result should be a random number between −9 and +9.
To save time, instead of actually having you look up digits in a phone book, we’ll
use the results of your 10-sided die rolls and add subtract a random digit generated
by Logger Pro. The result should appear in a column labeled Phone Book.
Be sure you understand why each of these sources of error obeys the “rules” of the
activity. In a real-life measurement, you would not be able to see the individual sources
of random error, only their aggregate effect; the purpose of this activity is to show you
how that aggregate effect can be in the shape of a Gaussian even if the individual sources
of error are not.
(C) The column labeled Result will automatically calculate the sum of the “true value” (100)
and the three random sources of error. Again, make a histogram of the final results.
This time, since there is a much wider possible range of final answers, the histogram bin
size will probably have to be changed. If it is kept at size 1, then almost every bin will
either be empty or have only one data point in it; but if you make the bins too wide,
then all or almost all of the data will fall into a single bin, which isn’t very useful either.
3 is probably an appropriate bin width for this activity.
(D) Does your histogram resemble a normal distribution? Try fitting a Gaussian function
to it. Click the
Curve Fit button and select the PS2 Gaussian function option. This
differs slightly from the program’s default functional form for a Gaussian, but has the
nice property that the parameter B is the mean of the distribution, and the parameter
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C is its standard deviation. 1 A represents the height of the peak. You may find that
the fit does not look anything at all like the data—for instance, the program may tell
you that the best-fit values of A, B, and C are much, much too large. To fix this, you
can manually edit the parameters to approximate values of what you think they should
be: the height of the tallest bin for A, the location of the peak for B, and the width of
the peak for C. The program will change the fit type from “Automatic” to “Manual.”
Once you have entered in reasonable-looking values, click on “Automatic” again and
then click on Try Fit. If it again fails to converge, ask your TF for help—probably your
data isn’t Gaussian enough for a fit.
One note: the program will tell you not only the best-fit value of the parameters B and
C, but it will also give you uncertainties on those values. Make sure you understand
what those uncertainties are telling you: the closer they are to zero, the better your
histogram approximates an exact Gaussian. But the reported uncertainty of B is not
the error of the mean, so don’t confuse it for that.
You may notice that the “best-fit” Gaussian distribution doesn’t actually fit your data
very well—most likely, the curve looks like it is a little too far to the left, relative to
where the bins are. Unfortunately, when Logger Pro fits a curve to a histogram, it treats
each bin as if it were a point located at the upper left corner (not the middle) of the
bin; if the bin is relatively wide, then this introduces a significant difference between the
peak of the Gaussian and the center of your histogram distribution. Can you determine
the true location of the peak of the Gaussian based on the calculated parameter B? This
is not a trivial question; your TF can help you think about it. (Hint: it has to do with
the Bin Start option in the histogram options dialog box, as well as whether the values
being binned are continuous or discrete.)
Once you have thought about this question, record the location of the peak (i.e. the mean
of the distribution) and the standand deviation of the distribution in your NoteBook file.
Also drag a copy of the histogram itself, with the Gaussian curve fit overlaid on it, into
the NoteBook.
(E) Now compute the mean and standard deviation of your data directly. But rather than
pulling out a calculator, you can get Logger Pro do to it for you using the Statistics
feature. Unfortunately, invoking this feature on the histogram does not have the desired
effect—it shows you the statistics for the frequencies, not the statistics we care about.
(In other words, it might tell you that the average bin has 5 data points in it, but what
we care about is the average value of the variable in the Results column.)
The way to do it is to create a graph where the variable you would like the statistics for
(in this case, the column labeled Results) is on the vertical axis. A reasonable choice of
variable to place on the horizontal axis is Row. Once you have made the graph, click
on the
Statistics button in the toolbar, or select Analyze → Statistics from the menu
bar. The program will open a small dialog box which shows you the min, max, mean,
standard deviation, and sample size of the selected variable. Compare the mean and
standard deviation of the data to the values of B and C of the best-fit Gaussian. How
close are they? If they are very different, can you think of a reason why they would be
different? Record them in your NoteBook file.
1

Actually, you might well find that the program computes a best-fit value of C which is negative, since the equation
for the Gaussian is exactly the same regardless of the sign of C. Don’t worry if this happens, just ignore the minus
sign.
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(F) Using the mean and standard deviation of your data (not from the Gaussian fit), compute
the standard error of the mean (refer to your handout on measurement and uncertainty
if you don’t remember what this is) for your set of measurements. Is your mean value
within one standard error of the true value (which is 100 in this case)? If not, is it within
two standard errors? Record your results in your NoteBook file.
(G) Write the names of your lab group members on the board at the front of the room and
note whether your “measurement” was within 1, within 2, or more than 2 standard
errors away from the true value. When the whole class has done this, calculate what
percentage of the groups was within 1 standard error, and what percentage was within
2 standard errors. How do these compare with the expected percentages? Make a note
of this, too, in your NoteBook file.
(H) Save your work and tell your TF when you are ready to move on. The TF will collect
the results of the entire class into a single Logger Pro file and display various histograms
showing the distributions of the final results. Compare to your own data set. What is
the mean of the whole class’s data? What is the standard error? Discuss these questions
with your lab group and put the answers in your NoteBook file, along with the whole
class’s histogram which the TFs will copy to your Desktop.
IV. Body temperature
The coins, dice, and random phone book digits are a model for the small sources of error which
influence any scientific measurement. Now you are ready to actually make some measurements
and see the effects of those random errors, even if you can not measure the individual sources
of error. As a testing ground for these ideas we will use the simple act of measuring your
body temperature.
(A) On the table are three commercial fever thermometers. Before you use them, wipe them
with an alcohol pad. Be sure to use the personal protection provided with the Leader
and Braun thermometers.
Each member of the lab group will use one of the thermometers to take his or her
temperature 30 times. These 30 temperature values are to be entered into the data
table on page 4 of the Logger Pro software.
See figure 1 for a picture of the thermometers.

Figure 1: Three commercial thermometers: (a) ThermoScan; (b) DTT; (c) Leader.
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• The Braun ThermoScan 4020 measures the infra-red spectrum (heat radiation) inside the ear canal. First, take off the hard plastic rounded cover on the thermometer
tip. Next, a cone-shaped probe cover must be snugly fitted onto the end for it to
work (and for hygiene purposes). Turn it on by pressing the Start button. Put the
end into your ear as far as is comfortable, and press the Start button again. In a
few seconds, it beeps and you can read the temperature. If you press Start again,
the display will reset; put it back into your ear and press Start for a second measurement. Repeat as needed. When you are done, the ThermoScan automatically
shuts itself off. Press the contoured green button above the display to pop off the
plastic protective cone so that the next person can use a fresh one.
• The DTT measures the temperature of a metal probe pressed against the temple.
There is no specific hygiene precaution for the temple probe. Press the blue button,
and the screen shows the last temperature measured. There is a little flashing
hourglass wait icon. When it goes out, the thermometer beeps twice. Without
pressing the blue button again, hold the metal probe against your temple. In about
five seconds, the thermometer beeps and you can read the temperature. To repeat
the measurement, first turn the DTT off by pressing the blue button.
• The Leader measures the temperature of the gold metal tip. It is used to take
oral temperatures. First, remove the hard plastic thermometer cap; then place a
probe cover over the thermometer tip before putting it in your mouth. The blue
button at the big end of the display turns the thermometer on or off. The button at
the tip end of the display is the mode button. By default, the thermometer turns
on in “fast” mode, which reads in about 5 seconds but isn’t very precise; regular
mode takes about 40 seconds but gives much more consistent readings. (Essentially,
regular mode waits for the temperature to stabilize and then beeps to tell you it is
done; fast mode looks at how quickly the temperature is going up in the first five
seconds and then tries to guess where it will level off.) The complication is that if
the thermometer is warmer than 87◦ F, it turns on in regular mode. This happens
when you make repeated measurements and the tip doesn’t have a chance to cool
off. You can tell which mode it enters because in fast mode, there is a stick figure on
the left and three blinking dashes until it beeps and gives a reading; in regular mode,
there is no stick figure and only a temperature display. The temperature eventually
stabilizes, and only then does the thermometer beep to indicate it is ready.
We would like half of the class to use fast mode, and half to use regular mode. If
you use regular mode, you will not be able to take 30 readings in the time it takes
your lab partners to do 30 readings on the Braun or the DTT thermometers. That’s
okay, but do at least 10 readings. If you are working at a computer labeled with
an odd number on the back of the monitor, use fast mode; this entails turning the
thermometer off and shaking it for a few seconds to cool it down to below 87◦ F. If
you are working at an even-numbered computer, use regular mode. The first time
you use it, you will have to press the mode button three times after the stick figure
appears to change it from fast mode to regular mode; after that, you can just turn
it on and put it back in your mouth as soon as the “L” appears to go right back
into regular mode before it has a chance to cool down.
(B) After each member of your lab group has taken their temperature 30 times using the same
thermometer, you can now investigate the properties of the thermometers themselves.
Based on your knowledge of statistics and your experiences with the earlier parts of this
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lab, use your 30 data points to estimate your body temperature. What is the uncertainty
on this estimate? What is the intrinsic precision of the thermometer? Hint: did you
just answer the same question twice?
Go ahead and make these calculations for each of the three of you. Be sure to record
the results, and any graphs or histograms you constructed in calculating those results,
in your NoteBook file. Don’t forget to indicate which person used which thermometer.
You may find that you run out of space on the screen as you are doing this part. To
add another page, simply click on the Page menu and select Add Page. To get the data
table to appear on the new page, go to Insert → Table.
(C) Which commercial thermometer works best? You may find in answering this question
that it helps to first define what “best” means.
(D) Now rotate thermometers, and measure your own temperature once each using the thermometers used by your lab partners. Based on the what you know of these thermometers
from your lab partners’ thorough investigations, what is the uncertainty of your one measurement? Is it the same as the uncertainty in your lab partner’s measurement from 30
repeated trials using the same thermometer? Why or why not? Record the readings, as
well as your answers to these questions, in NoteBook.
(E) Now you have taken your own temperature three different ways. How do the three
measurements compare to each other? According to Bates’ Guide to Physical Examination, temperatures taken in the ear are higher than oral temperatures by about 1.0 to
1.5◦ F. Did you find this to be the case? What about temple vs. oral, or temple vs ear
temperatures?
(F) The TFs will now show you the entire class’s data for this part. However, instead of
showing you the raw temperature data, they will take the data from the columns labeled
DTT offset, etc. which show the deviation of each of your measurements from the mean
of the entire column. Why do they do this? Looking at the combined results, which is
the best thermometer?
(G) Recall from your lab handout on uncertainty that there are two ways to improve the
standard error on your measurement: increase the number of trials, or increase the
precision of the measuring device. The two modes of the Leader thermometer give a
good example of this: how did the standard error from the fast mode (large σ, large N )
compare to the standard error from the regular mode (small σ, small N )? For a given
level of desired precision, which mode is a more time-efficient way of achieving that level?
You will have to compare with different lab groups who used the other mode. Like you
did for part III, go to the board and write: which mode you used for the Leader, what
your standard deviation was, and how many trials you took. Based on the whole class’s
data, we can decide which mode is more time-effective for the same level of precision,
doing fast mode many times or regular mode a few times.
(H) Throughout the lab period, the TFs have been taking aside one lab group at a time
to measure their axillary (armpit) temperatures and heart rate using the Vernier stainless steel temperature probe and heart rate monitor. The Vernier temperature probe
has been calibrated by the manufacturer and is accurate to within 0.05◦ F. How does
your temperature reading compare to the temperatures you took using the commercial
thermometers? Supposedly, axillary temperatures are 0.5 to 1.0◦ F lower than oral temperatures, and as much as 2 degrees less than tympanic (ear) temperatures. Did you
find this to be the case?
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When everyone in the class has done their temperatures and heart rates, the TFs will
show you the data for the whole class. What is the average body temperature of your
class? What is the uncertainty of this average? How does this compare to the “common
knowledge” average body temperature? Bear in mind that the study which established
98.6◦ F as the normal body temperature used oral thermometers, and oral temperatures
tend to be higher than axillary temperatures by about 1◦ F. Is your class’s data consistent
with the oft-quoted result?
Compare the temperatures of the men in your class with that of the women. Is the mean
temperature the same for both sexes? Does one sex have wider variation in temperature
than the other?
Is temperature correlated with heart rate? If so, what is the relationship between the
two? From your class data, how sure can you be of this relationship?
Try to answer all of these questions as best you can and put the answers in your NoteBook
file.

Picturing Science
Diagrams, pictures or carrtoons are often a key element of explaining science. The last task in this
lab is to draw a diagram or picture that would explain to a person on the street a central concept
of the lab you have just completed. You can be as creative as you want. Take a photo of your
picture with photo booth and include it in your NoteBook file.
One issue you may notice is that when you take a picture in the Photo Booth, it is automatically
reversed left-to-right as if you were seeing it in a mirror. This doesn’t matter for the purposes of
capturing your smiling faces, but when you take a picture of your drawing or cartoon it may make
more sense to view it the correct way. To fix this problem, go to the Edit menu in Photo Booth
and make sure to check the option “Auto Flip new photos.”

Conclusion
Congratulations, you’ve reached the end of the lab. Be sure to save both your Logger Pro file and
your NoteBook file. To submit your work, do the following:
1. Open a Finder window and locate the folder where you have saved your Logger Pro file and
your NoteBook file.
2. Click on one file, and then shift-click on the other so that both will be selected.
3. Under the File menu, select Create Archive of 2 items. You should see a new file appear in the
folder named Archive.zip.
4. Rename Archive.zip to a filename that includes all three of your names. For instance, the
filename could be “Lab 1 Marie Curie Albert Einstein Isaac Newton.zip” (and those three
could probably do a pretty good lab report!).
5. Now open Safari (the web browser) and go to the the course website for your class, either
PS2 or P11a (by default, Safari will open to the PS2 website) and log in with your Harvard
ID number.
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6. Click on the Labs page and find the dropbox with your lab day and time and click on it.
Make sure you use the correct dropbox; otherwise your TFs will never be able to find your
lab report.
7. Click on Upload File and upload the archive file you created. For a title, just call it “Lab 1
report.” Then click Submit.
8. Make ABSOSULETLY SURE the file ends up in the (correct) dropbox before you leave.
When you log out, all of your files will be wiped from your computer, so if your report is
not in the online dropbox the TFs will have no way of knowing you were here. If the upload
takes more than a few seconds, chances are it has failed; just click the back button on the
browser and try it again. (Just as a precaution, you are probably better off not logging out
of the iMac before you go, so that the TFs can check to make sure they have received your
lab report before it disappears forever.)
9. You only need to submit one report for the three of you, but you may want to email the file
to your lab partners since only the person who submitted the file (i.e. the person who entered
their Harvard ID to log into the website) can later view it from the dropbox on the website.
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